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Mit Hilfe der TauDEM-Tools kann in QGIS die Isozonierung durchgefiihrt werden. Allerdings
funktioniert sie nur in gewissen Kombinationen von QGIS- und TauDEM-Versionen. Die aktuellste
Version von TauDEM (5.3.7) lauft z.B. in QGIS 2.18 nicht, in QGIS 2.14 hingegen schon. In QGIS
2.18 muss die altere TauDEM-Version 5.1.2 eingesetzt werden. Ab QGIS 3 ist TauDEM nicht mehr
unter den Providern. TauDEM misste als Plugin angeboten werden, was momentan nicht der Fall ist.
Ob ab QGIS 3 die Isozonierung mit andern Tools ausgefihrt werden kénnte, wurde nicht geprift.

Die Anleitung wurde mit folgenden Versions-Kombinationen erfolgreich getestet:
e QGIS 2.14.8 mit TauDEM 5.3.7
e QGIS 2.16.3 mit TauDEM 5.1.2
e QGIS 2.18.0 mit TauDEM 5.1.2

Bei Problemen kann das BAFU keinen Support leisten.

1. Notwendige Unterlagen

e Ausschnitt eines digitalen Hohenmodells, in welchem das Einzugsgebiet komplett enthalten
ist.

o Koordinaten des Gebietsauflusses.

e Fur die Isozonierung werden die TauDEM-Tools bendtigt. TauDEM kann von folgender Seite
heruntergeladen werden: http://hydrology.usu.edu/taudem/taudem5/downloads.html bzw.
http://hydrology.usu.edu/taudem/versions.html

e Es empfiehlt sich, TauDEM unter C:\Program Files zu installieren. Auch QGIS sollte in diesem
Ordner installiert sein.

e Nach der Installation muss in QGIS TauDEM aktiviert werden. Zudem mussen die Pfade
eingegeben werden: Processing => Options => Providers.
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"f‘ Processing options @

Search...

Setting Yalue
* o GDAL/OGR
» o GRASSGIST cormmands
» g GRASS commands
> oh Modeleronly tools
> ﬁ Orfen Toolbox (Image analysis)
- ¥ QGIs geoalgarithrns
»x QuickOSM
> R Rscripts
- & sa5a
4 TauDEM (heedrologic analysis)
Activate
Enable multifile TauDEM tools
Enahble singlefile TauDEM tools
MPICH2/QpentdPI bin directory
Mumber of MPI parallel processes to use
TauDER commmand line tools folder ChPrograrm FileshTauDER\TauDEM5Exe
TauDEM multifile command line tools folder
© ¥ Tools for LIDAR data
> Scripts I8

m

EOE

MProgram Files\Microsoft MPTWEin

o]

oK ] [ Cancel

2. Korrektur digitales Hohenmodell
e Kinstliche Senken missen vor der Weiterverwendung korrigiert werden.
e TauDEM-Tool Pit Remove.

,'f Pit Rermuowe @
Parameters | Log Run as batch process...

Elewation Grid

|dhm [EPSG:21751] (]

Pit Rermoved Elevation Grid

[Sawe tao kemparary File] E]

Open oukput file after running algorithm

| 0%

Run l [ Close

2114

265.31-01095/00001/R385-0333



Referenz/Aktenzeichen: R385-0333
3. Fliessrichtung bestimmen

e Aus dem korrigierten digitalen Hohenmodell wird fiir jede Rasterzelle die Fliessrichtung

ermittelt.
e TauDEM-Tool D8 Flow Directions.

e Die Fliessrichtung kann auch mit dem TauDEM-Tool D-Infinity Flow Directions bestimmt
werden. Dieses Tool kommt beim Punkt 8 zum Einsatz. An dieser Stelle muss D8 Flow

Directions verwendet werden, damit im nachsten Schritt das Grid Network ermittelt werden

kann.
e Das Slope Grid wird nicht bendétigt und muss deshalb nicht erstellt werden.

,?' D8 Flow Directions

Parameters Log

(-8 [wESal

Pit Filled Elewation arid

|Pit Remived Elevation Grid [EPSG:21751] (e
D& Flow Direction Grid
[Sawe tao kemparary File] E]
Open oukput Flle after running algarithim
D Slope Grid
[Sawe tao kemparary File] E]
[] Open output: file after running algorithm

| 0%

Run l [ Close
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4. Totaler Fliessweg bestimmen
Aus dem flowdirection Grid kann fiir jede Rasterzelle der totale oberliegende Fliessweg

ermittelt werden.
TauDEM-Tool Grid Network.

Das Longest Upslope Length Grid und das Strahler Network Grid werden nicht benétigt und

missen nicht erzeugt werden.

Grid Metwork

Parameters Log

D& Flow Direction Grid

[ =

Run as batch process. ., |

|D8 Flow Direction Grid [EPSG:21781]

Outlets Shapefile [optional]

| [Mot selected]

Mask Grid [optional]

| [Mot selected]

Mask Threshold

100
Longest Upslope Length Grid

[Save to temparary File]

Open output file after running algaorithm

Tatal Upslope Length Grid

[Save to temporary File]

| Open output file after running algorithm
Strahler Metwork Order Grid

[Save to temporary File]

Open output file after running algorithr

0%

Fun | | Close
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Gebietsausfluss setzen
e Punkt-Shapefile erzeugen: Layer => Create Layer => New Shapefile Layer. Den Type Point

und das passende Koordinatensystem auswahlen.

5.

# Mew Shapefile Layer

Type

@ Paink

Palygon

L2 s

File encoding |System

EP5GiZ1781 - CH1903 [ LYO3

New field

Mame

Type | Texk data

Length =20

Fields list

Mame Tvpe
id Inkeger

Precision

Length
10

1

&dd ko figlds list

Precision

3

Remove field

[ o

] | Cancel

| | Help

e Eine Editier-Session starten: Rechtsklick auf das Punk-Shapefile => Toggle Editing

e Gebietsausfluss setzen: Edit => Add feature. Punkt an die gewlinschte Stelle setzen. Er muss
auf dem Gerinne (weisse/graue Linien) des Datensatzes Total Upslope Length Grid liegen.

e Editier-Session beenden: Rechtsklick auf das Punk-Shapefile => Toggle Editing.
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6. Einzugsgebiet bestimmen
e TauDEM- Tool D8 Contributing Area.
e Inputdaten sind das D8 Flow Direction Grid und der Gebietsauslass.

JDa Contributing &rea @

Parameters Log Run as batch process... |

-

D& Flows Direction Grid
D& Flow Direction Grid [EPSG:21751] v (]

Qutlets Shapefile [optional]

[ Gehistsauslass [EP5G:21761] - |[e) IEI

wyeight Grid [optional]
| (Mot selected] - ||:|

m

| Check For edge contamination
D& Contribuking Area Grid
[Sawe to kemparary File] [

| Open oukput file after running algorithm

0%

Run l | Close

6/14
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7. Hindernisgrid bestimmen

e Vom Total Upslope Length Grid wird bestimmt, welche Zellen zum Gerinne bzw. zur
Landoberflache gezahlt werden. Dazu wird ein Schwellenwert definiert. Das Ziel ist, ein
kinstliches Gerinnenetz zu erhalten. Durch den Vergleich mit der Landeskarte 1:25°000 oder
einem vorhandenen Linien-Layer des Gewassernetzes kann der Schwellwert durch
Symbolisierung des Total Upslope Length Grid iterativ ermittelt werden. Gewisse

Abweichungen sind normal.

e Die Symbolisierung kann in den Layer Properties vorgenommen werden. Folgende
Einstellungen eignen sich dazu. Render type: Singleband pseudocolor; Color interpolation:
Discrete. Add values manually (griines Pluszeichen). Der Value entspricht dem Schwellwert.

(3 Layer Properties - Total Upslope Length Grid | Style

w Band rendering

Render type [Singleband pseudocolar vl

Band

Band 1 (Gray) » | Generate new color map

I Color interpolation

Edit

Discrete - I -Oranges '][

] |:| Invert

R =X

»

E Mode |Continuous = [ Classes |5
VB tistogram Min 0 Max 15392.4
Walue Colar Label
f ek adaka 10000,000000 Custom color map ... Classify
| Metadata

m

Min J max origin:

Estimated cumulative cut of full extent,

Load min/max values

[ clip

w Color rendering

Blending mode [Normal

Style

& Cumulative a] . 2l o
@l T @ 20 = 95.0 5 %
() Min ) max
o~ Mean +/- x .
~ standard deviation = 2.00 [+
Extent Accuracy
@ Full @ Estimate (Fastar)
() Current () Actual (slower)
2
i r — &7
[ (o] 4 J [ Cancel ] [ apply ] [ Help ]
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Im vorliegenden Beispiel hat sich ein Schwellwert von 10°‘000 als sinnvoll erwiesen.

TauDEM-Tool Stream Definition by threshold:
Inputdaten sind das Total Upslope Length Grid und als Maske das Einzugsgebiet Contributing
Area Grid. Den ermittelten Threshold eingeben.

Strearn Definition By Threshold 7 @

Parameters | Log Run as batch process... |

Accumulated Stream Source Grid

[Tatal Upslope Length Grid [EPSG:21751] v [oe]

Threshald
10000 S

Mask, arid [optional]
[D& contributing Area Grid [EPSG:21751] v [oe]

Stream Faster Grid

| Open output Fille after running algarithim

0%

Run | | Close

Das Resultat ist Stream Raster Grid. Die Gerinnezellen haben den Wert 1 und die
Landoberflachenzellen den Wert 0.

Die Landoberflachenzellen erhalten den Wert Verinne / Viandoberfiache. Die Geschwindigkeiten
werden aus dem Diagramm bzw. Formel von Rickenmann abgeleitet.

Im vorliegenden Beispiel ist Veerinne = 1.5 m/s und Viandoberfizche = 0.5 m/s. Folglich erhalt die
Landoberflache den Wert 3 (=1.5/0.5) zugewiesen.

Mit dem SAGA-Tool Reclassify values (simple) wird den Landoberflachenzellen der Wert 3
zugewiesen. Die Gerinnezellen aus dem Stream Raster Grid behalten den Wert 1.

8/14
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1!' Reclassify walues (simple)

Parameters Log

arid

Run as batch process... |

7=

|Stream Raster Grid [EPSGI21781]

Replace Condition

|[EI] arid value equals low value

Lookup Table
Fixed table 2x3
Zhanged arid

| Open oukput File after running algorithm

/" Fixed table

Low Value High walue

== I

Replace| | Addrow |
[Remave ron(s)]|
[ Removeal |
[ o |

| Zancel |

-
z
™
()
0%
Close
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8. Fliessstrecke fiir jede Zelle bestimmen

e Die Fliesslangen werden von jeder Zelle bis zum Gebietsauslass des Einzugsgebiets
bestimmt. Damit die Berechnung entsprechend ausgeflihrt wird, braucht es folgendes Grid:
Die Zelle des Gebietsauslasses weist den Wert 1 auf, alle anderen Zellen des Einzugsgebiets
weisen den Wert 0 auf. Dieses Grid wird erzeugt, indem das D8 Contributing Area Grid aus
Schritt 6 reklassifiziert wird. Im D8 Contributing Area Grid entspricht die Zelle mit dem
héchsten Wert dem Gebietsauslass. Dieser Zelle wird der Wert 1 und allen anderen Zellen der
Wert 0 zugewiesen.

o Mit dem QGIS-Tool Raster layer statistics kann der maximale Wert im D8 Contributing Area
Grid ermittelt werden. Alternativ kann auch mit dem Tool Identify Features auf die Zelle des
Gebietsauslasses geklickt werden.

/" Raster layer statistics IEI

Parameters | Log Run asbatch process... | Raster layer statistics

Input laver This algorithm computes basic statistics from the
values in a rasker laver,

D& Contributing Area Grid [EP5G:21781] |
The raster laver must have a single band.

Skatistics

[Sawe to kemporary file] E]

0%

Run l [ Close I

,f Fesults @

Statistics Yalid cells: 9965

= Statisti

: ?S ?ES Mo-data cells: 855115
Skatistics

Statistics Minirnurm walue: 1,0
Statistics Maimurm walue: 99650
Statistics

Surm: 877649.0
Mean value: §8.0731560462

Standard deviation; 633, 146004773

10/14
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¢ Im vorliegenden Beispiel betragt das Maximum 9965. Entsprechend wird das D8 Contributing
Area Grid reklassifiziert.

? |[=
Parameters Log Run as bakch process...

Grid

,f' Reclazsify walues (simple)

[DB Contributing Area Grid [EPSG:21781] - ]

£

Replace Condition

[[2] Low value <= grid value < high value -

Lookup Table

Fixed kable 2x3 /" Fixed table
Changed Grid

Lo wal High tal Repl Add row
E:/Isnzonierung)Gebietsauslass_g. ki Dwaue Dt G

0 Remove rowls)

Open output file sfter running algorithn
2 9965 10000 1 Remove all

4

Jii:

Cancel

4 (L k

e Mittels Symbolisierung oder dem QGIS-Tool Raster layer statistics kann Uberprift werden, ob
das Grid Gebietsauslass_g wunschgemass erzeugt wurde.

,f Fesults @

Statistics Yalid cells: 9965

| Statisti

AHFHES No-data cells: 855115

Statistics

Thatistics Minimurn value: 0.0

Statistics Mazimum value: 1.0

Statistics

Statistics sum: 1.0
Mean walue: 0,000100351229303
Standard deviation: 0.0100175460719

1114
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TauDEM-Tool D-Infinity Flow Directions: Das Slope Grid muss nicht erzeugt werden. Das D-
Infintity Flow Direction Grid hingegen wird im nachsten Schritt fir die Berechnung der
Fliessstrecken benétigt. Das D8 Flow Direction Grid aus Punkt 3 kann dazu nicht verwendet

werden.

7 D-Infinity Flow Directions

Parameters Log

[ [mEsal

Pit Filled Elewvation arid

s

[Pit Removed Elevation Grid [EPSG:21781]

|

D-Infinity Flow Directions Grid

[Save to kemparary file]

Open oukput Flle after running algarithim
D-Infimity Slope Grid

[Sawe to kemparary File]

[7] open output: file after running algorithm

o]

m

o]

| 0%

Run l [ Close

TauDEM-Tool D-Infinity Distance Down: Als Stream Raster Grid wird das vorher erstellte Grid
Gebietsauslass_g und als Weight Path Grid das Hindernisgrid ChangedGrid aus Punkt 7
verwendet. Die weiteren Inputdateien und Einstellungen sind gemass folgendem Screenshot

vorzunehmen.

7 D-Infinity Distance Down

Parameters Log

[ [mESal

D-Infinity Flow Direction arid

| D-Infinity Flow Directions Grid [EPS@:21761] ][]
Pit Filled Elewation arid

|Pit Remived Elevation Grid [EPSG:21751] (e
Stream Raster Grid

| Gebietsauslass_g [EPSG:21751] (]

Weight Path Grid [optional]

| changedarid [EP5@:21761]

v L]

Statistical Method

[Average

v

Distance Method

[Hnriznntal

d

Check For edge contamination
D-Infinity Drop to Stream Grid
[Sawe to kemporary file]

Open oukput Flle after running algarithim

o]

| 0%

Run l [ Close
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9. Fliesszeit fiir jede Zelle berechnen

e Fir die Berechnung der Fliesszeit wird die Beziehung Zeit = Strecke/Geschwindigkeit
verwendet. Flr das gesamte Grid wird die Gerinnegeschwindigkeit eingesetzt. Damit die
Berechnung auch fir die Landoberflache stimmt, wurde im vorhergehenden Schritt die
Fliessstrecke auf der Landoberflache mit dem Faktor vaerinne/VLandoberfiache multipliziert.

e Raster => Raster Calculator: D-Infinity Drop to Stream Grid durch Vaerinne teilen und durch 60
teilen (=Minuten). Resultat ist das Grid fliesszeiten.

265.31-01095/00001/R385-0333

,i" Razter calculatar @
Raster bands Result layer
Changedaridml Output layer E:/Tsnzonierung/fliesszeiten [:]
D& Contributing Area Grid@1
D& Flows Direction Gridi@] Cutput Format IGBDTIFF - I
Ci-Infinity Drop bo Skrearn Gridid]
D-Infinity Flow Directions Gridi@1 Current layer extent
Gebietsauslass_gi@1 . = =
Pit Remowed Eleyation GErid@l B8 595335.85038 - mMax 62571385058 A
Stream Raster Grid@1 Ymin  139798.51831 s Vmax 157598.51831 :
Total Upslope Length Gridi@1
dhmi@! Columns 1215 = Rows 71z =
Output CRS Selected CRS (EPSG:21781, CH1903j Lv03)  + &)
Add result to project
w Operators
[ + I I i I I sqrk J [ cos I I sin I I tan J [ log10 ‘ I { I
- JL¢ JL ~ J[ aws J[ e J[ & J[ n J[ 3 |
L=< JL = JL = JL = JL = J[ == J[ & J[ e« |
Raster calculator expression
{ "D-Infinity Drop ko Strearm Grid@1" [ 1.5 [ 60
Expression valid
ok J [ Cancel
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10. Isozonen bilden
e Klassen der Fliesszeit bilden.

e SAGA-Tool Reclassify values (simple) auf Grid fliesszeiten anwenden. In der Regel machen

10-Minuten-Klassen am meisten Sinn.

,\'_Q' Reclassify walues (simple)

Parameters Log

&=

arid

| lisszeiten [EPSG:21751]

Replace Condition

[[2] Low value <= grid value < high value

Lookup Table

|Fi><ed table 5x3

¢ Fixed tahle

Changed Grid

E:iIsozonierungfisozonen, bif

Open aukput file after running algorithnmn
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2 1
320
4 30
5 40
g 50
7 60

g 70

Low Value

20

30

40

Al

all

7

an

High Yalue

Replace

Add row
Rermove row(s)
Rermove &l
QK

Zancel

Jii
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